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Introduction 
The Purchase Order Approval module works in concert with NorthClark’s Buyer’s Workbench, a 
Windows desktop application which may be used to view, create, and modify Purchase Requisitions, 
Requests for Quote, and Purchase Orders in your Manfact system.  The Buyer’s Workbench helps 
Manfact users manage the procurement process efficiently and with greater accuracy.   

The Purchase Order Approval module allows you to:  

 Establish company rules for signature requirements based on purchase order type, supplier 
status, various dollar thresholds, and other user-defined criteria. 

 Automatically route documents to the appropriate individuals for signature, and send email 
notifications requesting their approval. 

 Automatically place orders on hold until appropriate approvals have been received. 

 Obtain approvals using electronic “signatures” to authorize release of individual order line 
items. 

 Alert the Buyer when all items on an order have been either approved or rejected. 

The Purchase Order Approval application will reduce the risk of placing purchase orders without 
appropriate authorization, and simplify management of the approval process. 
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Purchase Order Approval 
Main Screen 
You may receive notification of purchase orders and/or requisitions requiring approval via e-mail, or if 
you are a Buyer, you may receive an alert on the Buyer's Workbench.  You may also view items 
requiring your approval by going directly to the Purchase Order Approval system and performing a 
search.  The “Search Criteria” options are shown when you start the application, as illustrated below. 

Search Options 
Use this screen to locate purchase orders and/or requisitions to view or update.   
 

 

You can use the available search fields in any combination to narrow your search.  If you don’t know the 
specific details of a particular field, you might use wildcarding to enter only a portion of the part 
number, project number, etc.  Please refer to the General Information section of this document for more 
information on wildcarding. 
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The fields you may use to narrow your search include: 
 

Record Type This option allows you to choose the type of records to be viewed, Purchase 
Orders, Requisitions, or both.   

Order Type(s) Choose any combination of the Order Types to be included in your search. 

Status Choose the status of the records you wish to view.  Normally you would choose 
only open items requiring approval, however other options have been made 
available if you wish to view past records.  

Filters Additional filters have been provided to narrow the search.  You may also search 
for a specific PO# or Requisition #, or filter by Supplier, WO#, Warehouse, 
Buyer, Part #, Description or Project ID. 

Date Ranges You may limit your search to records entered within a certain date range, or 
where the next due date is prior to a specified due date. 

Approval Levels      
Remaining 

You may limit your selection to only those orders awaiting specific Approval 
Levels, or you may also select only those orders that have been routed to a certain 
individual. 

Approval Name 
From 

"Remaining Approval Names" searches the list of people whose approvals are 
still required based on the Routing information. 

"All Approval Names”, searches the entire list of names, whether signatures have 
been posted or not. 

  
After you have entered all of the desired search fields, click on the [Search] button to begin the selection 
process.  The following is displayed while the search is progressing: 
 

 

  
The system is now generating the list of purchase orders and/or requisitions.  The results will be 
displayed on the “Items to Approve” tab.  Note that anytime during the selection process, you may click 
the [Cancel] button to stop the search.  
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Approving a Purchase Order or Requisition 

This view displays a list of records meeting your Search Criteria.  Colors are used to differentiate items 
by Status (open, approved, rejected, not required).  Note, you may choose the colors you prefer by 
selecting Display Options from the View menu.     

 

The top grid displays the list of orders you selected.  The bottom grid displays detailed approval 
requirements and history for a selected item.  Simply navigate to any cell on the top grid to see the 
details for that order. 

Only the “Action” and “Notes” columns may be updated using this procedure.  All other columns are for 
display only.  Choose the desired Action for each item, and then click the [Save] button to post and/or 
remove signatures. 

You may enter Action commands for the total order or for specific Rules.  When you choose to enter the 
action for the total order, using the upper grid, the action is automatically applied to all applicable Rules 
for the order.  If the order requires signatures for more than one Rule, your signature will be applied to 
each Rule where your Approval Level meets the requirements defined for the rule.  Use the lower grid if 
you want to enter an action for a specific Rule.   

If the same Rule Number appears more than once on the Rule Detail display, it means that multiple 
signatures are required.  The minimum approval level required for each signature is displayed.  You may 
not post more than one signature to the same Rule Number. 
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The "Remove Mine" and "Remove All" actions allow you to remove signatures that were previously 
posted to an item.  Note, to remove someone else's signature, you must have an Approval Level greater 
than the individual you are trying to remove. 

If during entry you receive the following error message, it indicates that you are trying to approve a 
requisition or purchase order where you are designated as the “Requestor”.  You may not approve your 
own requisitions or purchase orders. 
 

 

 

Column Definitions: 

Action  Select the desired option from the drop-down list:  
Approve, Reject, Remove Mine, Remove All 

Approver’s Notes  Free form text entry. 

 

Note, the remaining columns are for display only, and may not be changed: 

Buyer’s Notes Notes entered by the Buyer using NCC_BWB. 

System Notes System Messages  

Target Unit Cost The Target Unit Cost will be one of the following, depending on the option chosen 
in the System Administration screen: Current Standard Cost, Frozen Standard 
Cost, or Last Cost. 

Target Ext. Cost Target Unit Cost * Quantity Ordered 

Ext. Price The dollar value of the item awaiting approval. 

Ext. Variance Target Extended Cost - Extended Price 

Doc Type Type of Document:  Purchase Order (PO) or Requisition (REQ). 

Doc Id – Li# The Purchase Order or Requisition Number, followed by the Line Number.  

PO/REQ Date The Purchase Order or Requisition creation date. 

Status Current approval status of this item:  Open, Approved, Rejected, Not Required. 
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# Signatures 
Required 

The total number of signatures required for this item. 

# Signatures 
Posted 

The total number of signatures (approvals or rejections) applied to this item. 

 

Buyer Code The identifier of the Buyer assigned to the Purchase Order. 

Order Type 

 

1 - Inventory or Production Material shipped to a physical inventory location 
2 - Expense Items charged to specific General Ledger account 
3 - Capital Items charged to specific account 
4 - Inventory  or Production Material to Work Order (A Part Number is Required) 
5 - Direct Shipment from Supplier to Customer 
6 - Drop Shipment to another Supplier 
7 - Non-inventory costs to Work Order (No Part Number is Required) 
8 - Outside Processing charged to a Work Order 

Part Number The part number is a required field for Order Types 1, 4, 5, & 6. 

Description Description of the part or item to be purchased.   

Part Hold The Hold Code from the Manfact Parts file is displayed.  Hold Codes include: 

U - Discontinued, but flagged for "use until exhaust" effectivity.  
D - Discontinued item, no orders should be recommended. 
O - Obsolete part, should not be issued to work orders.  

Rev (Revision) Revision Level of the part.   

Start Order Date The date by which the order must be placed to meet the required date, based on the 
part lead time. 

Required Dates The date that the item is needed. 

Schedule Dates The scheduled delivery date(s) for the item.   

Order Quantity The total quantity ordered is the sum of all scheduled delivery quantities.   

Supplier Number 
and Name 

If the line item you are viewing is a requisition, the suggested Supplier is 
displayed. 

Vendor Hold Hold code from the Manfact Vendor file. 

Buy U/M The purchasing (buy) Unit of Measure required by the supplier.  This unit of 
measure can be different from the stocking unit of measure.  The conversion is 
performed by creating an appropriate Buy U/M Factor. 

6 



NorthClark Computing, Inc. 

Buy U/M Factor The multiplier used to convert from the purchasing (buy) unit of measure to your 
company's stocking unit of measure for this part.  For example, if you stock an 
item in discrete units (each), but purchase it by the dozen, the Buy U/M Factor 
would be 12.  Therefore, when you purchase 1 package, you will receive 12 units 
to stock. 

PO Price The unit price for this PO line item.  This price is based on the Buy Unit of 
Measure.  The system will automatically convert the pricing to the equivalent 
stocking unit price.  

The pricing may be entered in multiples of a single buy unit of measure.  This 
additional conversion is performed by entering the appropriate Price Per and Price 
Conversion factors. 

Price Per The number of units that the PO Price refers to.  The PO price entered for this line 
item will be multiplied by the total quantity and then divided by this factor. 

Price Conversion Used to convert the PO price to a factor other than the Buy Unit of Measure.  This 
information will default from the Parts file. 

Ext. Price Extended Price = Order Qty * PO Price * Price Conversion / Price Per. 

Foreign Price As applicable, the unit PO Price in Foreign Currency. 

Tax Type Tax types are defined in the Manfact TABLE.TAX procedure.   

Resource Code Valid resource codes are defined using the Manfact TABLE.WO entry procedure. 

Whse The Warehouse Code identifies the location where materials are to be delivered. 

Project The Project Number to be charged with this purchase. 

Work Order The Work Order Number that will receive the material or services.   

InvLoc  Manfact inventory location identifier.  

G/L Account The General Ledger Account Number to be charged for expense (type 2) or capital 
(type 3) purchases. 

Requestor The name of the individual that generated the requisition. 

Deliver To Free form user defined name of the location where the item is to be delivered.  

Last Cost The last actual cost recorded for the part from either a purchase order or work 
order. 

Printed Notes Free form notes to be printed on the purchase order line item.   
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Note Numbers Identifiers for user defined Notes from Manfact PURTEXT file.  The associated 
notes will be printed on the purchase order document.   

AML Approved Manufacturers List.   

Mfg.  Name Manufacturer of the item. 

Mfg.  Part # Manufacturer's part number for the item. 

Ship To Doc.  # Ship To Document number: Purchase Order or Sales Order Number.   

Ship To Line # Line number corresponding to the item on the Ship To Doc. 

Supply Parts? When this box is checked, it indicates your company will supply parts to the 
vendor for manufacture of the item ordered.   

OP Location If you are supplying parts to the vendor on this order, a Manfact outside 
processing inventory location will be shown. 

Parts To Supply If you are supplying parts to the vendor on this order, the list of Part Numbers is 
displayed here. 

Print? When this box is checked, the line item will be printed on the PO. 

A/P Acct# The Accounts Payable account associated with the line item being purchased.   

Early Days The number of days tolerated for early delivery.  Receipts that are too early will be 
placed on hold. 

Over Ship % Percentage of acceptable over-shipment.  Receipts containing quantities more than 
the allowable percentage will automatically be placed on hold. 

Hold Code Any entry in this column means the purchase order line item is on hold.   

Inspect When this box is checked, inspection is required upon receipt. 
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Rule Details 
One row is displayed for each Rule Number where a signature is required.  If more than one signature is 
needed, multiple rows may be displayed for the same Rule Number. 
  

 Action Select the desired option from the drop-down list:  
Approve, Reject, Remove Mine, Remove All  

Rule Number The identifier of the rule that applies to this order. 

Rule 
Description 

Description of this rule. 

Status  Open, Approved, Rejected, Not Required 

Approval Level The minimum approval level a person must have to approve this rule. 

Approval 
Person 

The suggested or actual approval person (depending on status). 
Note:  Actual approval person will print on the Purchase Order. 

Amount 
Approved 

The dollar amount approved. 

App/Rej Date Date or approval or rejection. 

App/Rej Time Time of approval or rejection. 

Notified Date Date Approval Person was notified that approval is requested. 

Notified Time Time of notification. 

Notified Via Email address used to notify Approval Person. 
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Main Menu Options 
Following is a brief description of the options available from the Main Menu of the Purchase Order 
Approval application: 
 

Menu Option Description 

File Clear Clear all current data on all displays. 

File Save Save your changes to the database. 

File Print Print the current active spreadsheet.   

File Export Export data from the active spreadsheet.   

File Exit Close the application. 

Edit Copy Copy data to the Windows clipboard.   

Edit Cut Cut data from the field and copy it to the Windows clipboard.   

Edit Paste Paste data from the Windows clipboard.   

Edit Fill Update all of the selected cells from the Windows clipboard.   

Edit Zoom View, print and/or edit the expanded contents of a field.  

View Unhide All 
Columns 

Expose all columns previously hidden. 

 

View Auto Fit 
Columns 

Automatically adjust the width of each column to accommodate your data.  

View Display 
Options 

Set user preferences affecting the appearance of the screen. 

Activities Batch Update 
Order 
Approval 
Requirements 

See Batch Update of Approval Requirements. 

Activities Send All 
Pending Email 
Notifications 

See Sending Email Notifications. 

Activities System 
Administration

See Purchase Order Approval Administration. 
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Tools Part Cost 
History 

See Part Cost History 

Tools Update PO 
Routing 

See Updating Routing Information. 

Tools View PO 
Attachments 

See View PO Attachments. 

Tools View PO 
Document 

See View PO Document. 

 
 
 

Right Click Menu 
When an item has been selected from the “Items to Approve” the following Right Click Menu options 
are available. 
 

Copy Copy data to the Windows clipboard.   

Cut Cut data from the field and copy it to the Windows clipboard.   

Paste Paste data from the Windows clipboard.   

Fill Fill will update all of the selected cells from the Windows clipboard.   

Zoom Zoom allows you to view, print and/or edit the expanded contents of a field.   

Part Cost History See Part Cost History. 

Update Routing for 
PO 

See Updating Routing Information. 

View Attachments 
for PO 

See View PO Attachments. 

View Document for 
PO 

See View PO Document. 
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Activities Menu 

Batch Update of Order Approval Requirements  

This process will reanalyze approval requirements for open purchase orders and/or requisitions.  Some 
examples where this option may be useful include: 

 Updating records that were created or modified using a program other than NorthClark’s Buyers 
Workbench. 

 Updating existing records after Approval Rules have been modified due to policy changes. 

 Updating approval requirements when implementing the Purchase Order Approval module for 
the first time. 

You may also use this feature to reanalyze the Rules for a specific order.  Note, updating of individual 
orders occurs automatically when the record is filed in the Buyers Workbench. 

To begin, select Batch Update Order Approval Requirements from the Activities menu.  Choose the 
desired option, then click the [OK] button to begin the update.  
 

 
 
The following message is displayed upon completion: 
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Sending Email Notifications 

You may configure the system to send email notifications to individuals whose signatures are needed on 
open purchase orders and/or requisitions.  To enable this feature, go to the System Administration screen 
and update the following options: 

 Select the Enable Email Notifications option on the General tab. 

 For each individual defined on the People tab, choose the “Wants Email” option, and enter their 
email address. 

Email notifications are stored in the Purchase Order Approval Message file while they are waiting to be 
sent.  These messages are created automatically when the system analyzes a PO or Requisition to 
determine its approval requirements.   

The system analyzes order approval requirements and creates email messages when records are filed 
using the Buyer’s Workbench.  This updating can also be triggered using the “Batch Update of Order 
Approval Requirements” option on the Activities menu.   

A message will remain in the queue until one of the following occurs: 

 Select the "Send All Pending Email Notifications" option from the Activities menu to 
immediately send all messages waiting in the queue. 

 Messages may be sent automatically, at user-specified time intervals.  To enable this feature, 
select the “Send Email Messages From BWB During Work Flow Update” option on the General 
tab of the System Administration screen.  This will cause Buyers Workbench to automatically 
send queued messages at the same time Work Flow update processing occurs.  Please refer to the 
Buyer’s Workbench documentation for more information on Work Flow processing. 

 
Please refer to the System Administration section for more information on setting up the system to 
deliver email messages. 
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Tools Menu 

Part Cost History 
Select this option from the Tools menu, or from the pop-up menu displayed when you right-click on the 
“Items to Approve” tab.  It displays a list of recent purchase orders, receipts and quotes for a selected 
part number. 

 

Enter a Part Number or use the pull-down menu to select a part number.  Part Numbers currently 
included on the “Items to Approve” display will be included on the list for your convenience.   

Decide if you wish to include Open PO's, Receipts, and Quotes on the list.  Click on one, two or all of 
these options. You must select at least one. 

You may enter a date range by clicking the appropriate checkboxes and entering the desired dates.  
Leave the checkboxes blank if you do not wish to limit your search by date.  Note: the search is 
performed on the date the PO or Quote was entered. 

Click the [Search] button.  A message will be displayed indicating that the search is being performed. 

At the bottom of the screen you may select a Cost Group from the drop down list, and the system 
displays the Current Standard Cost, Historical Average and Last Cost for the part.  Note, this 
information is obtained from Manfact’s Cost History (COSTHIST) file. 
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Updating Routing Information 

When a Purchase Order or Requisition requires approval, the system identifies the individuals who are 
most likely to provide those approvals, and sends them an email notification.  The “Routing” is the list 
of people who’s signatures are needed. 

The names of the people to be included on the routing can be determined in the following ways: 

 A specific individual’s name may be entered on the Rule definition tab on the System 
Administration screen.  Use this option if only one person is authorized to sign-off on the Rule. 

 The system may automatically assign someone based on Department.  Department codes are 
assigned to individuals using the People tab on the System Administration screen.  The General 
Ledger account number on the PO or Requisition line item identifies the department who’s 
approval is required. 

 The above options provide a “default” when the PO or Requisition is created.  The Routing 
information may be manually entered/changed when the record is filed in Buyer’s Workbench. 

 You can also view or update the Routing from the Purchase Order Approval application.  The 
Approval Routing screen may be accessed from the Tools menu, and also from the right-click 
menu available on the “Items to Approve” tab. 

To change the Routing information for the PO or Requisition, click on the drop-down box to identify 
persons authorized to approve the order.  Notes may be added if desired. 

 

 

 
Saving the changes will return you to the Items to Approve screen where you may continue with the 
approval and/or routing change process.  Choose [Cancel] to close the window without updating. 
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View Purchase Order Document 
Select this option from the Tools menu, or from the pop-up menu displayed when you right-click on the 
“Items to Approve” tab.  This will allow you to view an electronic copy of the Purchase Order that was 
previously deposited in the BWB Data Store from the Buyer’s Workbench.   
 
Note that the purchase order may be either a Word Document or a PDF file, depending on how the 
Buyer chose to create the file.  If it is a Word Document, you will need to have Microsoft Word™ 
installed on your computer, and the file will be opened in read-only mode.  If the file is in PDF format, 
you will need an appropriate reader such as Adobe Acrobat™ to access the file. 
 
Begin by clicking on the row on the “Items to Approve” tab where the desired Purchase Order is 
displayed.  The row will turn bold indicating it is the current active row.  Right-click to select the “View 
Purchase Order Document” option from the pop-up menu.  This option is also available from the Tools 
menu. 
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View Purchase Order Attachments 
The Buyer’s Workbench allows drawings and other attachments to be linked to purchase order line 
items.  A copy of each electronic file is deposited in the “BWB Data Store” for later retrieval.  The 
“View Purchase Order Attachments” option allows you to view the files the Buyer has linked to the 
order. 
 
Begin by clicking on the row on the “Items to Approve” tab where the desired Purchase Order is 
displayed, then right-click to select the “View PO Attachments” option from the pop-up menu.  This 
option is also available from the Tools menu. 
 

 
 

Each row on the screen represents one file that has been attached to the order.  If the attachment is a 
supported graphical file type, a thumbnail view of the image may be displayed in the Attachment Picture 
column (this can be enabled/disabled from the View menu).  Click on the [View Attachment] button to 
see a full screen view of the selected item. 
 
NorthClark applications support over 60 of the most popular raster image file formats and flavors 
including: JPEG, DICOM, FlashPix (FPX), Fuji Exif 2.0 (EXF), Adobe PhotoShop (PSD), Kodak 
PhotoCD PCD, EPS, IOCA, MODCA, CALS raster (CAL), Windows Icon (ICO), Windows Cursor 
(CUR), PC Paintbrush (PCX), Multipage PCX (DCX), IMG, Windows DIB, FAXraw, Winfax (WFX), 
MAC, VDA, GIF (Embedded Text, Animated, Interlaced, Transparency), CompuServe PNG, Targa 
(TGA), Sun Raster (RAS), Macintosh PICT (PCT), LEAD CMP, Windows BMP, OS/2 BMP, Microsoft 
FAX (AWD), Windows Metafile (WMF), WordPerfect (WPG), AVI, Microsoft Paint (MSP), TIFF 6.0 
(MPT, JPEG, Packbits, Huffman, RLE, LZW, CMYK, CCITT, CCITT G31D, CCITT G32D, CCITT 
G4, Bitonal, Grayscale, Palletized, RGB, YCbCr, CIELAB).  Note: a separate patent license from 
Unisys is required to use the GIF and TIFF LZW filters. 
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System Administration 
Purchase Order Approval Administration 
The System Administration view is accessed from the Tools menu, and is used to enter various 
parameters required to support the Purchase Order Approval process.  This function allows you to define 
Approval Rules based on purchase order type, supplier status, various dollar thresholds and other user-
defined parameters.  The Approval Rules describe the conditions where approvals are necessary, the 
number of signatures required, and the required Approval Level for each signature. 

The “People” tab of the System Administration screen is used to enter the names of individuals 
authorized to approve PO's and Requisitions, along with their Approval Level.  The Approval Level is 
indicative of the individuals title and rank within the company, and determines which Approval Rules 
each person is authorized to sign-off on. 

To access the System Administration function, you must be assigned the necessary privileges using the 
Manfact Security System.  Please refer to the “Security” section in this document for more information. 

 

General Options 
Use the “General” tab to define Approval Levels and Descriptions for your company, enable the 
Purchase Order Approval feature, and enter other miscellaneous system options. 
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Enable the Purchase Order Approval System 
Check this option once you have entered all the necessary parameters on all of the System 
Administration tabs, and are ready to "turn on" the Purchase Order Approval System.  This will cause 
the Buyer's Workbench to begin checking for approval requirements when requisitions and purchase 
orders are filed. 

Do Not Process PO’s Older Than This Date 
This option allows you to “grandfather” purchase orders that were entered before the NorthClark 
Purchase Approval System was implemented. When the Purchase Order date is less than the date 
specified in this field, signatures will not be required. 

Hold Code to Use 
The Manfact system supports the following Hold Codes for purchase orders: 

 A  = Accounting 
 C = Credit 
 E = Engineering 
 M = Manufacturing 
 P = Purchasing 

 
You will need to reserve one Hold Code for use by the Purchase Order Approval process.  This allows 
the system to take orders on/off hold when orders are created, approved, or rejected. 

Email Options: 

Enable Email Notifications When this option is enabled, email notifications are stored in the 
Purchase Order Approval Message file while they are waiting to be 
sent.  These messages are created automatically when the system 
analyzes a PO or Requisition to determine its approval 
requirements. 

To fully enable the system, you will need to enter information for 
each person who has approval authority.  Use the “People” tab to 
update the "Wants Email" option, and enter an email address for 
each person who will be notified in this manner.   

Send Email Messages From BWB 
During Work Flow Updates 

Messages that have been posted to the Purchase Order Approval 
Message file may be automatically emailed at user-specified time 
intervals.  When this option is chosen, the Buyer’s Workbench will 
check the queue and send email messages at the same time interval 
used for Work Flow Updates. 
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Calculate Price Variance Using 
Select one of the following to be used as the “Target Cost” when calculating the Purchase Price 
Variance: Current Standard Cost, Frozen Standard Cost, or Last Actual Cost. If desired, you may create 
a Rule that will require the Purchase Order to be approved when the Price Variance exceeds a specified 
percentage. 

Approval Levels 
Approval Level codes are used to identify the rank of individuals in your company.  This provides the 
system with information about the individual’s ability to sign-off on various approval requirements. 

Approval Levels An integer between 1 and 99.  You may wish to leave gaps between the 
numbers so new levels may be inserted later, e.g., 10, 20, 30, etc. 

Approval Level 
Descriptions 

Enter a description for each Approval Level. 

People Authorized to Approve Orders 
This screen is used to maintain the list of people who are authorized to approve Purchase Orders and 
Requisitions 

 

   

Login ID           Each person is identified by their Manfact Login Name.  This entry must exist 
in Manfact’s OPER file. 

Name The person’s name is displayed by the system and may not be changed. 

Plant(s) Enter the Plant(s) that the user is authorized to post approvals to in the pop-up 
window.  Click ok when all the Plant(s) have been entered. 
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Dept’s Optionally, you may assign one or more Department Codes to each person.  
This information is used by the system to locate the name of the person most 
likely to approve an order. 

Approval Level Select the Approval Level from the drop-down list.  The list of Approval Codes 
and Descriptions is defined on the General tab. 

Wants Email? Check this box if the person wants to be notified via email when a Purchase 
Order or Requisition requires their approval. 

Email Address The address used to send email to this person. 

Delete? Check this box to permanently delete this record from the file.  Note, you must 
hit the Save icon to confirm this action. 
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Approval Rules 

Approval Rules allow you to define your company's policies for signature requirements for various 
situations.  When an order or requisition is filed, the system checks each rule to see if it applies based on 
the order type, dollar amount, and other parameters.  If the rules apply, the order will require signatures 
from authorized personnel as defined for the rule.  Each rule may require one or more signatures, and 
each signature will have a minimum approval level.   
 

 
 
Rule Number The Rule Number is automatically assigned by the system when you click the 

Save icon. 

Rule Description A free form text box will pop up for entry of the description. 

Order Type 

 

1 - Inventory or Production Material shipped to a physical inventory location 
2 - Expense Items charged to specific General Ledger account 
3 - Capital Items charged to specific account 
4 - Inventory  or Production Material to Work Order (A Part Number is Required)
5 - Direct Shipment from Supplier to Customer 
6 - Drop Shipment to another Supplier 
7 - Non-inventory costs to Work Order (No Part Number is Required) 
8 - Outside Processing charged to a Work Order 

Line Item or Total 
Order? 

L = Rule applies to individual PO line items. 
T = Rule applies to all line items with qualifying Order Type. 
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Lower Limit This rule will apply to orders with a value greater than or equal to the amount 
entered in this field.   

Upper Limit This rule will apply to orders with a value less than or equal to the amount 
entered in this field.  If zero, infinity is assumed. 

Calculate Price 
Variance? 

Check this box to require approval when the difference between the PO price and 
the Target Price exceeds the Variance Percent Tolerated. The Target Price may be 
one of the following, depending on the option chosen on the General Tab: Current 
Standard Cost, Frozen Standard Cost, or Last Cost. 

Variance Percent 
Tolerated 

If the option was chosen to Calculate Price Variance, this rule will be applied 
when the variance percent is equal to or greater than the value specified in this 
field. 

Unapproved 
Suppliers Only? 

If checked, this rule applied to unapproved suppliers only.  If the supplier is listed 
in field #44 of the PARTS file, they are assumed to be approved, and this rule 
will be ignored. 

Suppliers On Hold 
Only? 

If checked, this rule applies only when the supplier is on hold. 

Compare To File 
Name 

You can create your own user-defined rules using the “Compare” feature to 
evaluate the contents of a specified field or calculated value.  Select the File 
Name that contains the data you want to use from the drop-down list.  Available 
choices are:  NCC_PO, NCC_POLI, NCC_POREQ, NCC_SUPPLIER, PARTS, 
PO, POREQ, and VENDOR. 

Compare To Field 
Number or I-Desc 

Enter the name of the field you wish to return from the specified file.  This can be 
either a data descriptor (D-Type) or an information descriptor (I-Type) data 
definition record in the file’s dictionary. 

Compare Option Select the equation that will be used in the comparison from the drop-down list. 

 

Compare To Value Enter the value that the field will be compared to.  If you are unsure of the exact 
value you may enter a portion of the value number followed by ... or *.  Make 
sure to select the Compare Option "Like" from the drop down menu selection.  
For example if you are searching for a Part Number that begins with ABC, enter 
ABC... or ABC*. 
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Approval Levels A pop-up window will be displayed for entry of the Approval Levels.  One or 
more Approval Levels may be entered, one for each signature required by this 
rule. 

Approved Person Optionally, you may enter the name of the person who will sign-off on the order 
when this rule applies.  This serves as a default value only, as the Buyer may 
indicate the actual person when the order/requisition is updated.  You may also 
select (Department) as an option, and this will allow the order to be routed to the 
first person assigned to that particular department. 

Please refer to the Manfact Setup Requirements section for more information 
about defining Department Codes. 

Email Option   Defines how email messages will be sent to the approval people: 

0 - Send All Messages At Once 
1 - Send Messages One At a Time 
2 - Do Not Send Email 

Choose the option to “Send Messages One At a Time” so that higher level 
managers will not receive notification until lower level signatures have been 
obtained.  Choose “Send All Messages At Once” if the order of approval is not 
important. 

Delete? Check this box to permanently delete this record from the file.   
Note, you must hit the Save icon to confirm this action. 
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Email Delivery Options 
The System Administrator must determine the preferred method of sending email based on the 
company’s available services.  If this is the first time you have implemented a NorthClark application 
with email features, you will need to enter these options.  These options are stored in the Windows 
Registry, and normally will not need to be changed once they are set.  
 
To update these options, choose Display Options from the View menu on the Main screen, then click the 
[Email Options] button. 
 
 

 
 
 
There are three primary methods for sending email: MAPI, Lotus Notes, and the Internet.  The first two 
options assume an email program such as Outlook, Eudora, or Lotus Notes is installed on the client 
computer.  The Internet option will send email directly, and does not interface with the users local email 
program. 
 

Tips for Using MAPI: 
If you are sending email messages via Outlook or Eudora, your email program needs to be set as the 
“Default MAPI Client”.  Please refer to your email program documentation to locate this setting. 
 

Tips for Using the Internet: 
These settings should be entered by someone who is knowledgeable about your company’s computer 
network.  Please contact NorthClark Computing, Inc. if you need assistance with this setup. 
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Manfact Setup Requirements 

Security 
Access to the Purchase Order Approval System is controlled through standard Manfact Security 
procedures (i.e., SEC.N, SECMC.N).  The table below lists the entries that may be added to each user's 
security table to enable various features: 
 
Procedure Name Enables This Feature 

NCC_POA Permits access to the Purchase Order Approval process. 

NCC_POAAdmin Same abilities as NCC_POA, plus the user may input signature rules and options 
defined in the System Administration screen within NCC_POA. 

 
 

General Ledger Department Codes 
The first time the Purchase Order Approval program is started, it will update the dictionaries of the 
Manfact PO and POREQ files with an I-Descriptor called NCC_DEPT.  This is used to parse the 
department number from the General Ledger account number entered on the PO or Requisition line 
item.   
 
For the system to work properly, it may be necessary to modify these I-descriptors to match your 
company’s General Ledger account number structure.  By default, the system assumes the Department 
number is the group of characters after the first “.” and before the second “.” in the account number.  For 
example, a structure like “CC.DDD.AAAA” where the first part is the company code, the second part is 
the department, and the last part is the account number.  Please contact NorthClark Computing, Inc. if 
you need assistance modifying this data descriptor. 
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General Information 
Printing a Spreadsheet 
Below is a sample of the screen that will appear when you select the Print option.  This will print the 
current active spreadsheet, so be sure to click on the spreadsheet you wish to print before choosing the 
Print option. 
 

 

Range - Selecting a Print Range  

You may choose to print the entire spreadsheet (all), selected cells (those that you have highlighted on 
the current screen), the current page (only the rows that are currently visible on your screen), or a range 
of page numbers.  

Orientation - Portrait or Landscape  

You may print your report in portrait mode (normal) or landscape mode (sideways). Printing in 
landscape mode will allow you to fit more columns of information on your report.  

Margins - Report Margins  

You can make your report more attractive by setting the top, bottom, left, and right margins. Reduce the 
left and right margins if you need to fit more columns on the report.  
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Units - Inches or Centimeters?  

Are the margins you entered expressed in inches or centimeters?  

Page Order  

If your report is too wide, it may span multiple pages. When this occurs, do you want the report printed 
from top to bottom or left to right?  

What Do You Want to Print?  

You can customize the appearance of your report by printing (or not printing) column headers, row 
headers, grid lines, borders, shadow, and color.  

Headers and Footers  

Your report may have up to three lines for the heading, and one line for the footer. The system initially 
displays a default heading, which you may modify if desired.  

Tip: Use /p to designate a page number.  

Which Columns Do You Want to Print?  

The columns that are available for printing are listed. Select the columns you wish to include on your 
report.  
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Importing Data From a Spreadsheet or Text File 

This screen is displayed when you choose the option to Import data from a Microsoft Excel spreadsheet, 
a tab-delimited text file, or a comma-separated text file.  The data will be imported to the current active 
spreadsheet, so be sure to click on the desired spreadsheet before choosing this option. 
 

 
 

Import File Name  

Enter the path for the file that you wish to import.  You may browse the files by clicking the button next 
to the text box. 

Header Rows 

Enter the number of rows at the beginning of the file that are not to be imported. 

Import File Type 

Select the type of file that you are importing. 

Data Mapping 

Enter the Column Number or Letter where data resides on the Excel file.   

Import Data 

Click OK to begin the import procedure. 
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Exporting a Spreadsheet to Excel 
Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 
 

 
 

Save As File Name 

Enter the pathname of the file you wish to create.  You may Browse the files by clicking the button to 
locate the drive and folder where the file will be stored. 

Sheet Name 

Enter the Excel sheet name to create. This will automatically default to Sheet1. 

Export to Excel or to a File? 

You may export the contents of the display directly to Excel, or you may choose to create a file in Excel 
format. 
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Create a Log File? 

Select this option to create a log file. The log file contains error messages and other information about 
how your Excel file was created. The name of the log file is "CreateExcelFile.log", and it will be stored 
in the same folder as your spreadsheet. 

Data Mapping 

You may move data to alternate columns by changing the column number or letter.  You may also 
remove a column by removing the row that contains the column information you do not wish to export. 

Export Button 

After all required information has been entered, click this button to export your data to Microsoft Excel. 
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Editing Features 

Copy, Cut, Paste and Fill 

You may use the standard Windows Copy, Cut, and Paste features to copy data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  

To copy data, hold down the left mouse button and highlight one or more cells, then choose Copy. 
There are multiple ways to enter this command:  

1.  From the Edit menu choose Copy. 

2.  Click the Right Mouse button, and then choose Copy from the pop-up menu.  

3.  Click the corresponding icon on the toolbar.  

4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 

You can use the Cut command (Ctrl-X) and the Paste command (Ctrl-V) in similar fashion.  

To copy the contents of an entire row, click once on the row header (the number displayed on the left 
side of the first cell), and then choose Copy. Now click on the row header that you want to copy the data 
to and choose Paste. 

If you want to update several cells with the same value, highlight all of the cells you wish to update then 
choose Fill Cells. This command will update each cell with the current information from the clipboard. 

 Zoom 
This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

• You may "Zoom in" on any selected item by selecting Zoom from the Edit Menu, clicking the 
magnifying glass on the toolbar, or selecting Zoom from the right click menu.   

• The Column Name will appear in the Title Bar with "Edit" or "View".  You may edit the field 
when it is allowed.   Click "OK" when finished, or "Cancel" to revert to the original data.  

• To print the selected item, click on the printer icon and the information will be sent to your local 
printer. 

Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, "View" 
will appear in the Title Bar, and there will only be a single command button labeled "Done". 
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Customizing Your Display / Arranging Columns 
Use the Customize Display Screen to make the following changes:  

 Each tab contains a list of fields that correspond to a screen used in this application. Use the 
checkboxes to show or hide each field.  

 Use the [Move Up] and [Move Down] Buttons to re-arrange the order in which the fields appear on 
the specific screen Display. Click [Reset All] to return to the system’s default settings. 

 Select the color to use for highlighting Rows that have been approved, rejected, or modified.  When 
you click the [Select Color…] button, a dialog is displayed allowing you to select from a color 
palette. 

 You may opt for the system to “Remember Screen Size and Column Widths”. Any changes you 
make to the screen's appearance will be saved and applied the next time you launch this application.  

 Choose the number of columns (from left to right) you wish to freeze on the spreadsheet. A frozen 
column will remain in place as you scroll to the right.  

 Click "OK" to apply any changes you have made or "Cancel" to revert to the previous settings. 

 

 
Note, these settings are stored in the Windows Registry for each user. 
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Wildcarding 
Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry. Here are some examples of wildcard commands and their expected results: 

Part Number:  XTR… (or 
XTR*)  

Returns part numbers that begin with “XTR”  

Description: …VALVE… 
(or *VALVE*) 

Returns parts with the word “VALVE” 
anywhere in the description.  

Category: …A (or *A)  Returns parts with a category ending with the 
letter “A”.  
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